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1 General Purpose of the Response Outreach Area
Mapper (ROAM)

The Census Bureau’s Response Outreach Area Mapper (ROAM) application was developed to
make it easier to identify hard-to-survey areas and to provide a socioeconomic and

demographic characteristic profile of these areas using American Community Survey (ACS)
estimates available in the Planning Database. Learning about each hard-to-survey area allows the
U.S. Census Bureau to create a tailored communication and partnership campaign, and to plan
for field resources including hiring staff with language skills. These and other efforts can
improve response rates.

Users include Census Bureau Field staff, regional office staff, local officials, other external
stakeholders and partners, and the public. The intent is to make this dataset more accessible to
assist outreach and planning efforts. Users visualize areas by predicted mail non-response rates
to determine the location of harder-to-count areas. Socioeconomic and demographic
characteristics provided by the American Community Survey (ACS) are available with a mouse
click for users to learn more about an area. Outreach and planning efforts can be well informed
and tailored by area.

This web mapping application provides the opportunity to make the Planning Database,
including a metric called the Low Response Score (LRS)—or more simply, predicted mail non-
response rate—much easier to use and access. The Planning Database is publicly available now,
but it is a large comma-delimited file and requires software (e.g., Excel, SAS, R) to open and
explore it. Beyond that, mapping the LRS requires an entirely different set of software and user
skills. Users can now simply open a web browser, look at a map of census tracts classified and
shaded by their LRS score, and quickly review a subset of the Planning Database variables
(including American Community Survey estimates) to help reveal why an area may be harder to
count. For example, a census tract where 52.6% of the households have no one in the household
age 14 or above who speaks English “very well” is helpful in understanding why response rates
may be lower there.

Specifically, the Census Bureau will use this tool to 1) plan outreach, marketing, and
promotional efforts, as well as 2) aide in the planning of recruitment activities and staffing.
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2 Census Bureau Planning Database (PDB)

Available online: https://www.census.gov/topics/research/quidance/planning-databases.html

The Census Bureau Planning Database (PDB) exists to plan field activities and for research
purposes. The PDB includes the Low Response Score, 2010 Census operational data, and select
American Community Survey (ACS) estimates. In its raw form, the PDB can be used in many
ways, including the following:

« Identifying areas where special outreach and promotion efforts could be considered.

o Linking spatial map data files to create thematic maps.

« Generating reports, cross tabulations, and simple analyses.

e Planning recruitment activities.

Hard-to-survey areas—those identified by higher Low Response Scores—across the country are
hard-to-survey for different reasons. Learning about each hard-to-survey area allows the Census
Bureau to create a tailored communication and partnership campaign, and to plan for field
resources including hiring staff with language skills. These and other efforts can improve
response rates.

The PDB is released at two levels of geography: 1) census tract, and 2) census block group. The
ROAM application exists at the census tract level.

3 Low Response Score

Nationwide, 79.3 percent of households that received a 2010 Census mail questionnaire
completed it and mailed it back. The resulting non-response rate of 20.7 percent was not evenly
distributed across the country, but rather varied greatly by location. The Low Response Score
(LRS) Ordinary Least Squares (OLS) regression model attempts to assign these variations in
response rate for individual census tracts given a set of characteristics available in the Planning
Database. In order to predict areas that are less likely to respond, we subtract the return rate from
100 and use that as the dependent variable in calculating the LRS. In other words, the LRS, or
fitted value from the OLS regression, is synonymous with "predicted mail non-response rate." As
an example, an LRS value of 17.7 should be interpreted as 17.7% of households in that census
tract are predicted to NOT self-respond to the decennial census.
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Reasons that an LRS is not calculated for a census tract can include:

e acensus tract contains zero housing units.

e acensus tract falls below a minimum threshold for qualifying addresses in the 2010
Census mailback areas.

e acensus tract has its 2013-2017 ACS 5-year estimates suppressed to avoid data
disclosure.

e acensus tract experiences a geographic boundary change between its 2010 Census
geography and 2017 geography for which the 2013-2017 ACS 5-year estimates are
based, making it non-comparable.

In this application, an LRS with no data value (null) indicates an LRS was not calculated.

4 General Application Use

Simply, users can click on a census tract to reveal additional information. In this application, no
data value (null) for the LRS indicates an LRS was not calculated. No data value (null) for the
ACS 5-year estimates indicates the data are not available in the Planning Database.

e Click on a census tract to generate a pop-up window.
e The pop-up indicates:
1. Identifying information.
2. Low Response Score.
3. List of ACS 5-year estimates.

On more advanced terms, users can query/filter a Data Table to reveal a subset of census tracts
that meet desired criteria. See Section 8, Using the Data Table.
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5 Application Interface Overview

The screenshot and descriptions below identifies the different buttons and features of the
application.

Response Outreach Area Mapper (ROAM)

+
L.
O

5.1 Navigate to a geographic entity

Allows you to search for a particular geographic entity to zoom to.

Search by:

e Address

o State

e County

e Census Tract

¢ Regional Census Center (RCC)

e Area Census Office (ACO)

o Tribal Areas: American Indian Reservation and/or Off-Reservation Trust Land; Hawaiian
Home Land (HHL); Tribal Statistical Areas including Alaska Native Village Statistical Areas
(ANVSAs), Oklahoma Tribal Statistical Area (OTSAS), State Designated Tribal Statistical
Area (SDTSAS), Tribal Designated Statistical Areas (TDSAS)

e Alaska Native Regional Corporation (ANRC)

e Minor Civil Division

e School Districts: Elementary, Secondary, and Unified
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e 116" Congressional District

e State Legislative District: Upper and Lower Chamber
e ZIP Code Tabulation Area (ZCTA)

e Place

5.2 Zoom Tools

Click the plus sign to zoom in. Click the minus sign to zoom out. Use the mouse wheel to zoom
in/zoom out or double click to zoom in.

5.3 Initial Map Extent

Refresh the view back to the contiguous United States. In other words, zoom out to the initial
map extent.

5.4 Current GPS Location

Zoom the map to your current GPS Location (functionality limited based on device/device
settings).

5.5 Extent Navigation

Click the arrow pointing left to go to the previous extent. Click the arrow pointing right to go the
next extent.

5.6 Change Basemap

Choose from various basemaps including satellite imagery and OpenStreetMap.

5.7 Bookmark

Save map extents that you need to revisit. Four bookmarks already exist within the application to
help navigate to Alaska, Hawaii, Puerto Rico, and the continental United States.

5.7.1 Create a Bookmark

Navigate to an area of interest, click the Bookmarks button, type a Bookmark Name, and
click the plus sign.

5.7.2 Go back to a Bookmark

Click the Bookmarks button and click on the desired bookmark.
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5.7.3 Delete a Bookmark

Click the Bookmarks button, click the bookmark to delete, and click “Delete” at
the bottom of the Bookmarks window.

5.8 Add Data

Allows you to look for other spatial datasets that already exist on the web. You can
temporarily add layers to the map. They will not be saved to the map for next time. The
layers you add with Add Data are visible in the Legend and Layers List.

You can use the “Search” tab to look for and add data from a pre-defined existing catalog
of data.

You can use the “URL” tab for other web-based spatial datasets. For example, you can
add any of the Census Bureau TIGERweb REST Services into the map. A good example
of a layer you may want to add is the Transportation (Roads and Railroads) layers. You
can click on the “Map Service Links” URL for the desired layer on the TIGERweb REST
Services webpage and then copy/paste the resulting URL into the Add Data “URL” tab:

https://tigerweb.geo.census.gov/arcqis/rest/services/TIGERweb/Transportation/MapServer

5.9 Legend

Defines the geographic boundaries included in the map by name and symbology as well
as the Low Response Score classification scheme. The layers visible in the Legend reflect
the layers currently visible on the map.
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5.10 Layer List

Allows you to turn on/off spatial layers.

In the left screenshot below, the red arrows point to a couple of checkboxes. Clicking any
checkboxes in the Layers List turn on (checked) or off (unchecked) the layers. Please
note if the “Additional Layers” checkbox is off/unchecked, any of the content nested
below will also turn off.

In the right screenshot below, the purple arrows point you to the “Transparency” slider bar,
which you can manipulate to make the Low Response Score thematic map darker or lighter.

Layer List A X || LayerlList A X
Operational Layers = Operational Layers =
«|v| Additional Layers e ~|v| Additional Layers
3 Regional Census Center (RCC) Layer vee b Regional Census Center (RCC) Layer
» Area Census Office (ACQ) Layer . 3 Area Census Office (ACO) Layer
American Indian, Alaska Native, and Native American Indian, Alaska Native, and Native
» - »
Hawaiian Areas Layer cee Hawaiian Areas Layer
» Minor Civil Division (MCD) Layer P » Minor Civil Division (MCD) Layer
- School District Layers P - School District Layers
¥ |»#| Unified School District . b || Unified School District
b || Secondary School District vee b |v*| Secondary School District
» |v| Elementary School District vee ¥ |v| Elementary School District
- Legislative Area Layers vee - Legislative Area Layers
b [w| 116th Congressional District en b [w| 116th Congressional District
N Elﬂte Legislative District - Upper N State Legislative District - Upper
Chamber oo Chamber
State Legislative District - Lower State Legislative District - Lower
rv| - = N g
Chamber Chamber
3 ZIP Code Tabulation Area (ZCTA) Layer [ » ZIP Code Tabulation Area (ZCTA) Layer
» Place Layer vee » Place Layer
b || Low Response Score by 2017 Census Tract ., ~|+| Low Response Score by 2017 Census Tmt\...
» 2020 Census Audience Segmentation en » 2020 Census Auc Transparency

The “Transparency” slider bar is revealed once you click on “Transparency”; you can
click on the slider marker as indicated below and drag it to the left (darker) or right
(lighter).

Opagque ’_/ Transparent

[ =] ]
0% 0% 100%
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5.11 About

The place to find basic information about the Planning Database and the Low Response Score
and how to interpret it. Also contains source information.

5.12 Share

Allows you to share the application with others by creating a URL to send or to post on social
media. You can simply copy/paste the link generated automatically or you can click on Link
Options to define how the map will get shared. You can define where the map is centered so that
you can share a specific area with someone else. In the Link Preview box, a URL will be
generated for you to copy/paste, or you can go back to the main pane and click one of the social
media icons to share your newly customized URL in that manner.

You can also copy code to embed the application in another website from this pane.

5.13 Data Table Access

The spatial identifier information and data from the Planning Database; Can filter/query;
Show/Hide columns.

6 Pop-Up Overview

The screenshot below identifies the functions of the pop-up that results when you click on a census tract.

Maximize

nsus Tract 8024.05
nce George's County, Maryland Scroll

Low Response Score (%): 29.8

2013- 2017 ACS 5-year estimates

ACS Self-Response Rate: 42.0
Total Population: 3,816
Median Household Income ($): 61,863
Median Age:
By Population UnderS (%): 9.41
Wl Fopulation 18-24 (%): 6.92
/ Papulamn 65 and Over (%): 12.84
s Below Poverty Level (%): 7

Chﬂdsen Under 18 Living in Povarry
(%):7
School El\rolled Children Age 3 and 4 (%)
Not High School Graduate (%): 493
No Health Insurance Under 19 (%): 2.78
No Health Insurance Age 19-64 (%): 2.77
No Health Insurance Age 65 and Over =

- Zoom to ...

ZoomTo

: Ellipsis

o Close — close pop-up
o Maximize — make the pop-up larger
e Scroll —scroll through the data in the pop-up
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e Zoom to — zoom to the extent of the selected tract
e Ellipsis — click to access additional pan to, add a marker, and view in attribute table

Note: When you click on a census tract you are not zoomed into, the application may indicate that several
census tracts were selected. If you would like to click a specific census tract, zoom in further to that area
before clicking on it. The yellow arrow in the screenshot below indicates you have selected two census
tracts. If you click the white arrow head in the pop-up window, you can scroll through all two. This may
also happen if you have several different layers of geographies turned on. Click the white arrow head to
circulate through the selected features.

Consus Tract B019.08.
Frince Gaorge's County, Maryland

Low Response Scare (% 334

20132017 ACS 5-yar o

7 Data Table Overview

The screenshot below identifies the functions available within the Data Table.

£i3 Options v Filter by Map Extent @ Zoomto [X] Clear Selection ( Refresh

Show Selected Records  fp TRACTCE GEOID  « | NAMELSAD STCOUEP
Show Related Records 020100 01001020100  Census Tract 201 01001

Y Filter

@ Show/Hide Columns

#, Export All to CSV 020200 01001020200 Census Trect 202 | 01001
01 001 020300 01001020300 Census Tract 203 | 01001
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1. Options Menu
a. Show Selected Records — if you have selected records, this field will be active and
only show the selected records in the Data Table
. Show Related Records — not an available option; it will always be grayed out
c. Filter — use this to Filter/Query the Data Table; see Section 8, Using the Data
Table section for details
d. Show/Hide Columns
e. Export All to CSV (.csv is a simple file format used to store tabular data)
2. Filter by Map Extent — when clicked as indicated by a blue rectangle around the button

the Data Table will only contain records for census tracts in view: ~-==" 220 \When
off (as in the screenshot above) the Data Table will include all census tract records

3. Zoom to — zoom to the selected census tract; can also double click on a record in the Data
Table to zoom to a given area

4. Clear Selection — deselect any selected records

5. Refresh — click if the Data Table becomes unresponsive

7.1 View Full Variable Name

To see the full extent of a variable name in the Data Table, hover over the column

division in the header of the table until your cursor becomes *<I* . At that point, you can
click and drag the column to the right to reveal the full column name. Please see Section
7.2.2 Planning Database Fields/Additional Documentation, Section 7.2.3 Federal
Communications Commission Fields/Additional Documentation, and Section 7.2.4 2020
Census Audience Segmentation Data/Additional Documentation for information about
the column/attribute names.

pct_Prs_Blw_Pov_| pct_Prs_Blw_Pov_ pct_Mot_HS_Grac pct_Mot_HS_Grad

15.27 45 11.82 2.90
14.74 7.90 8.32 476
30.90 792 0.38 3.85
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Full column/attribute name as seen below:

pet_Prs_Blw_Pov_Lev_ACS_13_17 | pct_Prs_Blw_Pov_| pct_Children_in_F pct_Children_in_F
52.57 10.20 77.06 10.32
2008 10.02 4141 15.04
40.79 14.98 5316 1473

7.2 Data Dictionary for Data Table

The screenshot below identifies the category of fields included in the data table. Below, is
a description of these:

Spatial Fields

Planning Database Fields

Federal Communications Commission (FCC) Fields
2020 Census Audience Segmentation Field

ALS_1317  Sel_Peponte e ALSMOR_13,17 o

Federal Communication Commission Fekds
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7.2.1 Spatial Fields

These fields are defined as:

FIELD TYPE DESCRIPTION
STATEFP Text value State FIPS codes
COUNTYFP Text value County FIPS codes
TRACTCE Text value Census tract codes

Census tract identifier; a
concatenation of state FIPs
code, county FIPS code , and
census tract code

GEOID Text value

Translated legal/statistical
NAMELSAD Text value area description and the
census tract name

Census tract identifier;
concatenation of

FULLNAME Text value NAMELSAD. COUNAME,
and STNAME fields
COUNAME Text value County name
STNAME Text value State name
STCOUNAME Text value Concatenation of COUNAME

and STNAME fields

7.2.1.1 Spatial Fields Additional Documentation

Census Tract Information
https://www?2.census.gov/geo/pdfs/maps-
data/data/tiger/tgrshp2017/TGRSHP2017 TechDoc_Ch3.pdf
e See “3.4 Census Tracts” for general background
information
e See “3.4.1 Census Tract State-based Shapefile Record
Layout (Current)” for description of the spatial-related
fields

American National Standards Institute (ANSI) Codes Reference
Information
https://www.census.gov/library/reference/code-lists/ansi.html

State FIPS Codes information
https://www.census.gov/library/reference/code-lists/ansi.html#par textimage 3
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County FIPS Codes information
https://www.census.gov/library/reference/code-lists/ansi.html#par_statelist

Or reference the entire nation’s worth of counties and FIPS codes directly:
https://www2.census.gov/geo/docs/reference/codes/files/national _county.txt

7.2.2 PDB Fields/Additional Documentation

Within the application, the Planning Database Fields in the Data Table
match exactly as they are in the actual PDB so that users can download
data from the application and then refer back to the full PDB for additional

variables. Full definitions and explanations of these are here:
https://www.census.gov/research/data/planning_database/2016/docs/2016-Tract-
PDB-Documentation.pdf

7.2.3 FCC Fields/Additional Documentation

Within the application, the FCC Fields in the Data Table match exactly as
they are in the actual FCC dataset. Full definitions of the fields can be
found in ROAM’s data dictionary at census.gov/roam. For additional
information:
https://www.fcc.gov/reports-research/maps/residential-fixed-internet-access-
service-connections-per-1000-households-by-census-tract/

7.2.4 2020 Census Audience Segmentation Field/Additional
Documentation

Within the application, the 2020 Census Audience Segmentation Field is
the last column in the Data Table. A full definition of the field can be
found in ROAM’s data dictionary at census.gov/roam. For additional
information:
https://www.census.gov/programs-surveys/decennial-census/2020-
census/research-testing/communications-research/2020-tract-segments.html

8 Using the Data Table

8.1 Sort
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Click on any column heading in the Data Table to Sort the Data Table by that column.
Choose to sort ascending or sort descending.

Low_Response Score | Mail Return Bate

170 Sort Ascending
Sort Descending
Statistics

18.4 faFvpes |

240 798

19.9 7935

213 g1.2

8.2 Filter

Under the Options menu, click Filter option. Filtering allows you to limit the rows of data
in the Data Table. Only features that meet the criteria will be visible in the Data Table.
You can filter based on any of the columns that are available in the Data Table.

8.2.1 Add a filter expression

To create a simple query, use this option.

i

o o -

m
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Example: Show records where the Low_Response_Score is between 25

Filter x
© Addafiler expression €@ Add an expression set
Low_Response_Scol is between 25 and kLN <]
®Value Field Unique
=

8.2.2 Add an expression set

Use this option when you would like to create multiple filters at once.

e x
o e [+
tk t [+
24
&\alue Field Unigue
Low_Response_Sco | = is greater thi 0
=Value Field Unigue
=

Resulting Data Table below shows that 113 features meet ALL criteria;
All of the records where Low_Response_Score is greater than 30 in the

state of Maryland:

81 0 selactac
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8.3 Download

To download data from the Data Table, click the Options Menu - Export All to CSV.
Keep in mind that “All” either means 1) ALL the features, or census tract records,
currently in the Data Table, or 2) ALL the selected features currently in the Data Table.

In the example below, 113 features will be exported to a CSV because there are no

selected features.

Response Qutreach Area Mapper (ROAM)

2017 Census Tract (from 2019 Planning Detabese)

P TRACTCE ‘GEQID
404202 24005404202

@ Show/Hide Columns

4 Export All to CSV
ﬁd—"m‘ 703214 24031703214

24 031 702000 24031702000

24 045 000300 24045000300

i13 features 0 selected

Filter by Mep Extent @ Zoomto [ Clear Selection (3 Refresh

NAMELSAD

Census Tract
404202

Census Tract
7032.14

Census Tract
7020

Census Trect 3

STCOUFP
24005

24031

24031

24043

FULLNAME

Census Tract
404202,
Baftimore
County, MD

Census Tract
7032.14,
Montgomery
County, MD

Census Tract
7020,
Montgomery
County, MD
Census Trect 3,

Wicomico
County, MD

‘COUNAME

Baltimore
ou!

County
Montgomery
County
Montgomery
County

Wicomico
County

STNAME

Maryland

Maryland

Meryland

Maryland

STCOUNAME

County,
Meryland

Montgomery
County,
Maryland

Montgomery
County,
Maryiand

Wicomico
Tounty,
Maryland

Low_Response_Score

322

344

In the example below, a user selected one of the census tract records by clicking on it in
the Data Table. Now, the 1 selected feature will be the only feature downloaded into the
CSV. Use the “Clear Selection” button on the Data Table if you would like to download
all of the current census tract records. Or, Shift+Click multiple rows in the Data Table if
you only want to download a handful.
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Feature Selected
Response Outreach Area Mapper (ROAM)

+ u Use dropdown to search

2017 Census Tract [from 2019 Plenning Detabese) ‘
£ Options ¥ Filter by Mep Extent @ Zoomto [X] Cleer Selection () Refresh

STATERP COUNTYFP TRACTCE GECID NAMELSAD  STCOUFP FULLNAME COUNAME STNAME STCOUNAME | Low_Response_Score
24 005 404202 24005404202 | CensusTrect | 24005 CensusTrect | Baltimare Mearyland Baltimere 322
404202 404202, Coumty County,
Baktimors Maryland
County, MD

24 |03t 702000 24031702000 | CensusTrect 24031 CensusTrect  |Momgomery | Maryland Momgomery | 30.9

7020, Courty County,
Montgomery Maryland
County, MD
24 1045 000300 24045000300 Census Trect3 | 24045 Census Trect 3, | Wicomico Meryland Wicomico 344
Wicomico | County | County,
County, MD | Maryland

13 features 1 selected

8.4 Microsoft Excel

To open the resulting .csv download in Microsoft Excel with the proper leading zeroes on
the STATEFP, COUNTYFP, TRACTCE, and GEOID fields, follow the steps below:
1. Open Microsoft Excel first rather than double-clicking on the .csv file.
2. File > Open
3. Navigate to the downloaded .csv file; you may have to select “All Files” from
the file type drop dox to be able to see it; click “Open”

@ Cpen x
4+ s ThaPC s OSDisk(C) » v B | Search Downicads P
Organize = Hew folder e @
A Name A Date moddied Type Size
0112017 Census Tract (from 2019 Planming D...  &/10/2015 1129 AM  Mecrosoft Eacel C.n 1588
I This PC
I Desicp
& Dovmloads
B Mus
| Pictures
B videos
L. O5Disk (C)
v % s
File rarne: [2017 Cmias Traet {rem 2019 Planrung Dtabase).cov W AllFies () -
— ; -
vos - Wopm ] | e |
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4. Make sure the “Delimited” radio button is chosen; click “Next”

The Text Wizard has determined that your data is Fixed Width.
If this is correct, choose MNext, or choose the data type that best describes your data.

Criginal d pe
Choos e file type that best describes your data:

@ Delimited - Characters such as commas or tabs separate each field,

O Fixed width - Fields are aligned in columns with spaces between each field.

Start import at row: |1 +| File arigin: 65001 : Unicode [UTF-8)

D My data has headers.

Preview of file Y %2017 Census Tract {from 2019 Planning Database).csv.

1 PBJECTID, STATEFP, COUNTYFP, TRECTCE, GEOID, NAMELSAD, STCOUFP, FULLNAME , COUNAME| A
9952, 24,003, 930000, 24003930000, Census Tract 3300,24003, "Census Tract 330
|z ko300, 24,033, 80008, 24023800608, Census Tract S00&.08, 24033, "Census Tract
|4 k0301, 24, 033, B00EOT, 24033800607, Census Tract S00E.07, 24033, "Census Tract
s 0305, 24, 033, 800707, 24033800707, Census Tract S007.07, 24033, "Census Tract |w

< >

Cancel Finish

5. Check the “Comma” option from the “Delimiters” section; click “Next”

Text Import Wizard - Step 2 of 3 ? x

This screen lets you set the delimiters your data contains. You can see how your text is affected in the
preview below.

Delimiters

[ 1ab

[] semicolon [] Treat consecutive delimiters as one

Text gualifier: |~ ~

|:| Other:

Data preview

BJECTID [STATEFP [COUNTYFE [TRACTCE [FEOID LMELSAD TCOUFE | M
25552 24 o032 S0000 4003530000 Lensus Tract 5500 24003

0z00 4 033 O0g02 [BE4033200€02 Census Tract 200£.08 240323

0201 24 033 00e07 pR4033200€07 LCensus Tract 200€.07 p4033

0305 4 033 00707 [R4033800707 [Census Tract 2007 .07 24033 W

£ >

Cancel < Back Finish

20|Page



Shift+Click the STATEP, COUNTYFP, TRACTCE, GEOID columns in the
Data Preview so that all four fields are highlighted and then click the “Text”
radio button; click “Finish”:

Text Import Wizard - Step 3 of 3 ? x

This screen lets you select each column and set the Data Format.

Column data format

O General
@: o ‘General converts numeric values to numbers, date values to dates, and

A all remaining values to text.
I:J Date:

() Do not jmport column [skip

mMoY Advanced...

2. THEN, click

1. 5hift + Click "Text" radio button

Data preview

Epe s zeperal
PEJECTID F ETCCUEE (™
Boa9z Tract 9500 E4003
30300 Tract 200€.0%8 R4033
F0301 Tract 800€.07 B4033
30305 Tract 2007.07 E4033 W
< >

You now have the subset of data you downloaded from the application in a
format where the leading zeroes are not lost.

A B C D E
1 |OBJECTID|STATEFP COUNTYFP  TRACTCE GEOID

2 963 01 o1 020100 01001020100
3 960 01 ‘o1 ‘020200 01001020200
4 129101 ‘01 ‘020200 01001020200
5 965 01 ‘001 ‘020400 ‘01001020400
6 129301 ‘001 ‘020500 01001020500
7 962 01 (] ‘020600 01001020600
8 964 01 o1 'o20700 01001020700
9 a1am o1 ‘020801 01001020801
10 27501 ‘o1 ‘020202 ‘01001020202
11 96101 ‘001 ‘020900 ‘01001020900
12 129401 ‘oo1 ‘021000 01001021000
13 129201 ‘oo1 ‘021100 01001021100
14 56001 ‘003 'o10100 01003010100
15 56901 ‘003 ‘010200 01003010200
16 55601 003 ‘010300 01003010300
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9 Resources

Refer to www.census.gov/roam for additional information.

Questions about the Low Response Score or Planning Database can be directed to:
Census.PDB.questions@census.gov

10 Known lIssues

e When you click on a census tract you are not zoomed into, the application may indicate
that several census tracts were selected. If you would like to click a specific census tract,
zoom in further to that area before clicking on it. The yellow arrow indicates you have
selected five census tracts. If you click the white arrow head in the pop-up window, you
can scroll through all five.

Census Tract 74.03
District of Columbia

Law Response Score (%): 40.0

2013 2017 ACS S-yoar estimates

ACS Self Response Rate: 22.3
Total Population: 3,187

Y Median Household Income (S 25,761
Median Age: 26.3
Population Under & (%) 4,64
Population 18-24 (%): 13.65
PFopulytion 65 and Over (%) 4.24
Persons Below Poverty Level (%) 39,62
Children Under 18 Living in Poverty
(%): 49.50
School Enralled Children Age 3 and 4
1%):
Not High Schoal Graduate (%): 10.44 ¥
Mo Health Insurance Under 19 (%): 5.91

e When you click on a census tract you are not zoomed into and click “Zoom to” in the
pop-up window, you may see that the entire census tract is not selected once you are
zoomed to it (see below left). Re-click on that particular census tract to see the actual
boundary of the census tract (see below right).
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http://www.census.gov/roam
mailto:Census.PDB.questions@census.gov

e You can access this application on a smartphone or other web-connected device.
However, the Filter actions are not very device friendly at the moment.
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